

  
Language
Afrikaans
Albanian
Arabic
Armenian
Azerbaijani
Basque
Belarusian
Bulgarian
Catalan
Chinese (Simplified)
Chinese (Traditional)
Croatian
Czech
Danish
Dutch
English
Estonian
Filipino
Finnish
French
Galician
Georgian
German
Greek
Haitian Creole
Hebrew
Hindi
Hungarian
Icelandic
Indonesian
Irish
Italian
Japanese
Korean
Latin
Latvian
Lithuanian
Macedonian
Malay
Maltese
Norwegian
Persian
Polish
Portuguese
Romanian
Russian
Serbian
Slovak
Slovenian
Spanish
Swahili
Swedish
Thai
Turkish
Ukrainian
Urdu
Vietnamese
Welsh
Yiddish



	
		
			
								
					
						Robert James Metcalfe Blog
					
				

				RJM Programming WordPress site (Copyright © rjmprogramming.com.au 2015 All rights reserved.) 


										
                    								


			
			  				Skip to content

									Home
	About
	All Posts	Trending Searches on this Blog
	Code Download Table
	Filter Content via Div ID
	Query Monitor
	Show Most Popular Words of Next Blog Posting 
Show Most Popular Words of Current Blog Posting
	Show Tags Menu
	Temporary User CSS
	Temporary Windows Print Button
	Toggle Context Help Mode to Off
	Toggle Download Mode from GETME
	Change User Controllable Font, Border, Background Settings


	Chat
	Contact
	Course
	Emoji  📨 Menu
	One Image Site
	Poll
	Privacy
	Word Search
	Language



                Language
Afrikaans
Albanian
Amharic
Arabic
Armenian
Azerbaijani
Basque
Belarusian
Bengali
Bosnian
Bulgarian
Catalan
Cebuano
Chinese (Simplified)
Chinese (Traditional)
Corsican
Croatian
Czech
Danish
Dutch
English
Esperanto
Estonian
Finnish
French
Frisian
Galician
Georgian
German
Greek
Gujarati
Haitian Creole
Hausa
Hawaiian
Hebrew
Hindi
Hmong
Hungarian
Icelandic
Igbo
Indonesian
Irish
Italian
Japanese
Javanese
Kannada
Kazakh
Khmer
Kinyarwanda
Korean
Kurdish
Kyrgyz
Lao
Latvian
Lithuanian
Luxembourgish
Macedonian
Malagasy
Malay
Malayalam
Maltese
Maori
Marathi
Mongolian
Myanmar (Burmese)
Nepali
Norwegian
Nyanja (Chichewa)
Odia (Oriya)
Pashto
Persian
Polish
Portuguese (Portugal, Brazil)
Punjabi
Romanian
Russian
Samoan
Scots Gaelic
Serbian
Sesotho
Shona
Sindhi
Sinhala (Sinhalese)
Slovak
Slovenian
Somali
Spanish
Sundanese
Swahili
Swedish
Tagalog (Filipino)
Tajik
Tamil
Tatar
Telugu
Thai
Turkish
Turkmen
Ukrainian
Urdu
Uyghur
Uzbek
Vietnamese
Welsh
Xhosa
Yiddish
Yoruba
Zulu


			

			
			
		

	

	

	






















Click me for Search Report if Not Already Showing



		

		
			

				
					← Animated GIF Creator PDF Share Tutorial

					Animated GIF Creator PDF Last Reveal Tutorial →

				


				
					Animated GIF Creator PDF Order Tutorial


					
						Posted on November 4, 2021 by 


   

					


					
						Animated GIF Creator PDF Order Tutorial


Order becomes an interesting subject to us today regarding the PDF conversions possible in amongst the Animated GIF creating of yesterday’s Animated GIF Creator PDF Share Tutorial.

That is because we may have some advanced users out there that want that possibility of differentiating the data of …

	animated GIF … containing all features asked for, in totality … from the chance for the user to have any of the PDF conversion option sets below …
	PDF … one of …
	no PDF conversion
	full PDF conversion … with the user choices regarding raw image content and title and watermarking and ImageMagick and GD modifiers
	light PDF conversion … with the user choices regarding just raw image content (the only option out of these last three available before today’s work)
	medium PDF conversion … with the user choices regarding just ImageMagick and GD modifiers





 … perhaps as a “before and after” tool regarding presentations, maybe?

No dropdowns used here (enforcing an order), just the user’s order in which they choose to select the “PDF conversion” option from the ImageMagick dropdown (in relation to other selections) determining how and when this PDF conversion occurs in the workflow through to creating the animated GIF with our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator serverside PHP web application.  Just remember to select PDF Conversion as early as possible to do that “light PDF conversion” option above and last thing if you are interested in “full PDF conversion” (where you can create PDF documents with the bells and whistles ImageMagick and GD modifiers can offer) and today’s tutorial picture is an example of “medium PDF conversion” (when we ordered our settings by first Grayscale, second PDF conversion and last title and watermarking options).  Clicking or tapping the ImageMagick link can get the user to the Javascript popup window where they might define the email or SMS recipient for that PDF conversion data file download.





Previous relevant Animated GIF Creator PDF Share Tutorial is shown below.

Animated GIF Creator PDF Share Tutorial


To share yesterday’s Animated GIF Creator PDF Conversion Tutorial PDF data formatted image slides (and then onto an animated GIF) would be a step forward, wouldn’t you say?

What sharing conduits do we code for?  We always intended …

	email … but as the day wore on trying to get the usage to work on mobile and non-mobile we decided to relinquish our wish to not have to create a user specific enduring (until that same browser type and user combination share) PDF document for the user request … mainly to get mobile email downloads to be friendly … and so this opened the door for …
	SMS … to access that enduring PDF as a URL in the SMS message (that becomes a link for the recipient)


 … the email methodology used being that “midair feeling” Ajax/FormData approach in our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator serverside PHP web application …

<?php echo ”



function emailhtmlit() {

 var induri=ginduri;

 var pemail='" . urldecode($_GET['outpdf']) . urldecode($_POST['outpdf']) . "';

 if (pemail != null) {

   if (pemail.indexOf('@') != -1 || (pemail.trim() != '' && pemail.trim().replace(/0/g,'').replace(/1/g,'').replace(/2/g,'').replace(/3/g,'').replace(/4/g,'').replace(/5/g,'').replace(/6/g,'').replace(/7/g,'').replace(/8/g,'').replace(/9/g,'') == '')) {

   if (induri.trim() == '') {

   if (induri == '') {

   document.getElementById('pdfproposed').src='./animegif.pdf?rand=' + Math.floor(Math.random() * 19854654);

   } else {

   ginduri='found';

   }

   setTimeout(emailhtmlit, 15000);

   } else {

   ginduri='';

  var zhr = new XMLHttpRequest();

  var zform=new FormData();

  if (pemail.indexOf('@') != -1) { zform.append('to', pemail); }

  zform.append('inline', '" . dirname(__FILE__) . DIRECTORY_SEPARATOR . "animegif.pdf" . "');

  zform.append('subj', 'My PDF version of Animated GIF via RJM Programming ... ');

  zform.append('tdhuhta', ('<body><div title=\"" . explode('/animegif',$durlis)[0] . '/animegif/' . server_remote_addr() . "_\" style=\"overflow:auto;-webkit-overflow-scrolling:touch;height:100%;\"><object style=\"width:100%;height:900px;\" type=\"application/pdf\" data=\"" . dirname(__FILE__) . DIRECTORY_SEPARATOR . 'animegif.pdf' . "\"><embed style=\"width:100%;height:900px;\" type=\"application/pdf\" src=\"" . dirname(__FILE__) . DIRECTORY_SEPARATOR . 'animegif.pdf' . "\"></embed></object></div></body>'));

  //zform.append('tdhuhta', ('<body><iframe srcdoc=\"" . dirname(__FILE__) . DIRECTORY_SEPARATOR . 'animegif.pdf' . "\"></iframe></body>'));

  zhr.open('post', '//www.rjmprogramming.com.au/HTMLCSS/emailhtml.php', true);

  zhr.send(zform);

  if (pemail.indexOf('@') == -1) {

    var hrefp=document.getElementById('pdfsms').href.split('&body=')[0];

    hrefp+=pemail.trim() + '&body=' + document.getElementById('pdfsms').href.split('&body=')[1];

    document.getElementById('pdfsms').href=hrefp;

    document.getElementById('pdfsms').click();

  }

  }

   }

 }

}



“;   ?>

 … and this called on our PHP email creator helper to better interface in its $_POST arguments reading section in our changed emailhtml.php inhouse email creator helper serverside PHP web application …

<?php



$psacv="";

$okayin=true;

$subd="";

$subptitle='';

$subdata="";

$subfile="";

$getpostfound=false;

<br>

foreach( $_POST as  $name=>$val ) {

  if ($val != "") {

// blah blah blah    //file_put_contents("jnv." . $name, "jnv.inv00 " . strlen($phpcont));

  if ($name == "tdhuhta" && $subfile != "" && $subdata != "" && strpos(str_replace("+"," ",urldecode($val)), $subfile) !== false) {

   if (strpos(str_replace("+"," ",urldecode($val)), ' srcdoc="') !== false || strpos(str_replace("+"," ",urldecode($val)), ' data="') !== false) {

      if (strpos(str_replace("+"," ",urldecode($val)), ' title="') !== false) {      //file_put_contents('haaa.aaa',explode('/animegif/', explode('"', explode(' title="', str_replace("+"," ",urldecode($val)))[1])[0])[1]);

        if (!file_exists('../PHP/animegif/' . explode('/animegif/', explode('"', explode(' title="', str_replace("+"," ",urldecode($val)))[1])[0])[1] . 'animegif.pdf')) {

        if (file_exists('../PHP/animegif/animegif.pdf')) {

          copy('../PHP/animegif/animegif.pdf', '../PHP/animegif/' . explode('/animegif/', explode('"', explode(' title="', str_replace("+"," ",urldecode($val)))[1])[0])[1] . 'animegif.pdf');

        }

        }

        $psacv=explode('"', explode(' title="', str_replace("+"," ",urldecode($val)))[1])[0] . 'animegif.pdf';

        $subptitle='<a target=_blank href="' . explode('"', explode(' title="', str_replace("+"," ",urldecode($val)))[1])[0] . 'animegif.pdf">Mobile whole PDF</a><br>';

      }

     $vrest=explode('"', explode(' srcdoc="',str_replace("+"," ",urldecode($val)))[1])[0];

     $val=urlencode("<body>" . $subptitle . "<iframe style='width:100%;height:95vh;overflow:auto;-webkit-overflow-scrolling:touch;' srcdoc='<div style=width:92%;height:95vh;overflow:auto;-webkit-overflow-scrolling:touch;><object id=myobj style=width:95%;height:95vh; type=application/pdf data=\"" . $subdata . "\"></object></div>'></iframe></body>");

   }

// blah blah blah

   if ($name == "inline") {

    if (strpos(str_replace("+"," ",urldecode($val)), 'animegif.pdf') !== false && isset($_POST['tdhuhta'])) {

     if (file_exists(str_replace("+"," ",urldecode($val)))) {

      $subfile=str_replace("+"," ",urldecode($val));

      $subdata='data:application/pdf;base64,' . base64_encode(file_get_contents(str_replace("+"," ",urldecode($val))));

      $val="";

      $name="x";

      $okayin=false;

     }

    }

// blah blah blah

  }

}



?>

Creating the PDFs got helped out in “reliability terms” via the introduced animegif.php inhouse Wait Around Longer serverside PHP web application.





Previous relevant Animated GIF Creator PDF Conversion Tutorial is shown below.

Animated GIF Creator PDF Conversion Tutorial


Up to yesterday’s Animated GIF Creator Slide Specific Application Tutorial the recent progress had us …

	knowing the good places to intervene between the original slide image data being read in and the animated GIF slide output … and …
	involvement of ImageMagick … so, today, these two help us down the path to …
	adding PDF as an output format possibility, in addition to the animated GIF and other ideas floated as output formats


 … with our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator serverside PHP web application.

We have more “reliability work” and “email sharing work” to go after today’s start, but it primarily called on ImageMagick command line’s talent for a command like …



convert /tmp/imtmp0*.*[gGmMiI]* /tmp/imtmp000.pdf



 … to “concatenate” into the one output PDF file (called “/tmp/imtmp000.pdf”) the slides, arranged by our code into that “/tmp/imtmp0*.*[gGmMiI]*” (file specification) arrangement above.  Yes, we meant “convert” above, as “mogrify” (batch work) appears not to be able to perform this task.

We hope you stay the course!





Previous relevant Animated GIF Creator Slide Specific Application Tutorial is shown below.

Animated GIF Creator Slide Specific Application Tutorial


It’s all fine and good improving on the ImageMagick and GD and Exif functionality modifications like with yesterday’s Animated GIF Creator Exif Rotation Compensation Tutorial, but in reality, if you are going to start creating animated GIFs to explain a process, you are going to want to apply these “slide modifiers” on a slide by slide basis, rather than enforcing a “whole of animated GIF slide set” paradigm, as for the last few days worth of work.

And so, we decided to do what we often do, “sliding in” more functionality (chortle, chortle).  We tend to want to …

	start with hardcoded text (or element) … somewhere … today it happens to be in an HTML span element that once involved just …



<span id="smyim"></span>



 … and used to get filled, Javascript DOM wise, when needed via …



document.getElementById('smyim').innerHTML='ImageMagick switches: ';   // and yes, it remains that way even now, but read on ...



	add intelligence (quite often that being onclick logic(s)) to that hardcoded element via …



<span id=smyim title=Application onclick=applyto(); style=cursor:pointer;text-decoration:underline;></span>



	that serves the purpose, as the user clicks/taps it (alerted to that fact, perhaps, because we underline the element and add an appropriate cursor when hovering over it (plus a title)), of calling Javascript …



function applyto() {

  var huhto=prompt('Apply ImageMagick and/or GD to which slides, in comma separated list, counting starting with 1?  Defaults to applying to all slides.  Comma delimit.  Negatives mean all but.  Ranges can be specified.  For example ... 2,4-7,9', document.getElementById('appliedto').value);

  if (huhto == null) { huhto=''; }

  if (huhto.trim() == '') {

    document.getElementById('appliedto').value='';

    document.getElementById('smyim').title='Application';

  } else {

    document.getElementById('appliedto').value=huhto.trim();

    document.getElementById('smyim').title=huhto.trim();

  }

}



	to glean an (often times out of the normal workflow of the web application) informational piece of data, interactively, from the user, via a Javascript prompt popup


So that’s the clientside of this work … “alerting the user to the existance of the functionality” you might say.

And then there’s “the application” of that nuanced user requirement.  And that’s where the “inhouse ‘our’ prefix to wrapper function name paradigms” come in handy.  We introduced “blanket” functionality thoughts via this approach, and so to “partially undo” that thinking, we make the “our” prefix conditional, as is available to us with our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator serverside PHP web application (helped out by a changed exif_rotation_check.php inhouse Exif detector PHP helper), as per …

<?php



function ourcomplicated($inio, $iappl) {

  $ideasl=explode(",", str_replace(' ','',$iappl));

  $xour="our";

  for ($iqa=0; $iqa<sizeof($ideasl); $iqa++) {

    if (trim($ideasl[$iqa]) != '') {

      $xour="";

      if (('-' . $inio) == trim($ideasl[$iqa])) { return "";  }

      $ideasr=explode("-", str_replace(' ','',trim($ideasl[$iqa])));

      for ($iqb=0; $iqb<sizeof($ideasr); $iqb++) {

        if (('' . $inio) == trim($ideasr[$iqb])) {

          return "our";

        }

        if ($iqb == 1) {

          if (trim($ideasr[1]) == "") { $ideasr[1]="99999999"; }

          if ($inio >= $ideasr[0] && $inio <= $ideasr[1]) { return "our";  }

        }

      }

    }

  }

  return $xour;

}



?>

 … teamed with …

<?php



  $ours="our";

  for ($io=1; $io$ours=ourcomplicated($io, $iappliedto);

    // blah blah blah

    if (strpos($aphoto[0], ";base64,") !== false) {

      $gifphp.=str_replace("imagecreatefromjpeg('source01.jpg');", "" . $ours . "imagecreatefromstring(base64_decode('" . explode(";base64,",$aphoto[0])[1] . "'));", str_replace("\$text='';", "\$text=\"" . str_replace("+"," ",urldecode($atext)) . "\";", $eachonestring));

    } else if (strpos(strtolower($aphoto[0]), "//") !== false) {

      $gifphp.=str_replace("imagecreatefromjpeg('source01.jpg');", "" . $ours . "imagecreatefromstring(@file_get_contents('" . $prefix . $aphoto[0] . "'));", str_replace("\$text='';", "\$text=\"" . str_replace("+"," ",urldecode($atext)) . "\";", $eachone));

    } else if (strpos(strtolower($aphoto[0]), ".jp") !== false) {

      if (strpos($prefix, "../../") !== false && !file_exists($prefix . $aphoto[0]) && file_exists(str_replace("../../","../",$prefix) . $aphoto[0])) {

        $prefix=str_replace("../../","../",$prefix);

      }

      //file_put_contents('qpqp.qpqp', $eachone . "\n\n" . $atext . "\n\n" . str_replace("\$text='';", "\$text=\"" . str_replace("+"," ",urldecode($atext)) . "\";", $eachone));

      $gifphp.=str_replace("imagecreatefromjpeg('source01.jpg');", "" . $ours . "imagecreatefromjpeg('" . $prefix . $aphoto[0] . "');", str_replace("\$text='';", "\$text=\"" . str_replace("+"," ",urldecode($atext)) . "\";", $eachone));

      //file_put_contents('qpqpqp.qpqpqp', $gifphp);

    } else if (strpos(strtolower($aphoto[0]), ".png") !== false) {

      if (strpos($prefix, "../../") !== false && !file_exists($prefix . $aphoto[0]) && file_exists(str_replace("../../","../",$prefix) . $aphoto[0])) {

        $prefix=str_replace("../../","../",$prefix);

      }

      $gifphp.=str_replace("imagecreatefromjpeg('source01.jpg');", "" . $ours . "imagecreatefrompng('" . $prefix . $aphoto[0] . "');", str_replace("\$text='';", "\$text=\"" . str_replace("+"," ",urldecode($atext)) . "\";", $eachone));

    } else if (strpos(strtolower($aphoto[0]), ".gif") !== false) {

      if (strpos($prefix, "../../") !== false && !file_exists($prefix . $aphoto[0]) && file_exists(str_replace("../../","../",$prefix) . $aphoto[0])) {

        $prefix=str_replace("../../","../",$prefix);

      }

      $gifphp.=str_replace("imagecreatefromjpeg('source01.jpg');", "" . $ours . "imagecreatefromgif('" . $prefix . $aphoto[0] . "');", str_replace("\$text='';", "\$text=\"" . str_replace("+"," ",urldecode($atext)) . "\";", $eachone));

    } else if (strpos(strtolower($aphoto[0]), ".bmp") !== false) {

      if (strpos($prefix, "../../") !== false && !file_exists($prefix . $aphoto[0]) && file_exists(str_replace("../../","../",$prefix) . $aphoto[0])) {

        $prefix=str_replace("../../","../",$prefix);

      }

      $gifphp.=str_replace("imagecreatefromjpeg('source01.jpg');", "" . $ours . "imagecreatefrombmp('" . $prefix . $aphoto[0] . "');", str_replace("\$text='';", "\$text=\"" . str_replace("+"," ",urldecode($atext)) . "\";", $eachone));

    }

    // blah blah blah

  }



?>

We use these “new abilities” better explaining “the abscence or otherwise of Exif checking”, and the implications of that in the animated GIF creator woooooorrrrrrlllllddd, contrasting the first two slides, showing one with “No Exif checking” (the bad old days) versus “With Exif checking” (the renaissance of liberated thinking in the South South East woooorrrrrlllldddd) in today’s animated GIF presentation.

Get the picture?!





Previous relevant Animated GIF Creator Exif Rotation Compensation Tutorial is shown below.

Animated GIF Creator Exif Rotation Compensation Tutorial


The recent couple of days of work like yesterday’s Animated GIF Creator GD Transformations Interfacing Tutorial have given us “rotation functionality” tools to counteract the unusual effects Exif …


Exchangeable image file format (officially Exif, according to JEIDA/JEITA/CIPA specifications) is a standard that specifies the formats for images, sound, and ancillary tags used by digital cameras (including smartphones), scanners and other systems handling image and sound files recorded by digital cameras.



 … can have converting mobile device camera created images into animated GIFs via our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator PHP web application.

But with some photos it’s there in the photo’s metadata information letting the future user know what orientation the camera of that mobile device was in as you took the photo.  In order to help our animated GIF creator, the first slide image is scoured for Exif metadata and if found, a suitable rotation correction can be applied to the slides there and then.  In order to scour for Exif metadata we needed to write a exif_rotation_check.php inhouse Exif detector PHP helper.





Previous relevant Animated GIF Creator GD Transformations Interfacing Tutorial is shown below.

Animated GIF Creator GD Transformations Interfacing Tutorial


The PHP GD image library is so much more useful than for the “filters” interfaced to with yesterday’s Animated GIF Creator GD Filter Interfacing Tutorial.  Under an “umbrella term” transformations, today we add interfacing to GD functionality …

Crop Default
Crop Transparent
Crop Black
Crop White
Crop Sides
Crop Threshold
Scale
Rotate
Copy Merge
Copy Resized
Fill



 … into our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator PHP web application.  We found it more user friendly to tailor the asking of numerical parameters for these GD calls work via …

<?php



 $gfcds='';

 $gdfs=[];

 if (strpos(($imvgn . $imafn . $imqty . $imgds), '|') !== false) {

    $gdfs=explode(';', trim(explode('|', $imvgn . $imafn . $imqty . $imgds)[1]));

    for ($itf=0; $itf<sizeof($gdfs); $itf++) {

     if (trim($gdfs[$itf]) != '') {

      if (trim($gdfs[$itf]) == strtolower(trim($gdfs[$itf]))) {

      $gfcds.=chr(10) . " imagefilter(" . "$" . "oimo, IMG_FILTER_" . strtoupper(trim($gdfs[$itf])) . "); " . chr(10);

      } else if (trim($gdfs[$itf]) == strtoupper(trim($gdfs[$itf]))) {

      $gfcds.=chr(10) . " image" . explode(',',explode(" ",strtolower(trim($gdfs[$itf])))[0])[0] . "(" . "$" . "oimo, IMG_" . str_replace(" ","_",strtoupper(trim(  str_replace(explode(' ',$gdfs[$itf])[0] . ' ','',$gdfs[$itf])   ))) . "); " . chr(10);

      } else if (strpos(strtoupper(trim($gdfs[$itf])), "SCALE") !== false) {

      $gfcds.=chr(10) . " $" . "oimo=image" . explode(',',explode(" ",strtolower(trim($gdfs[$itf])))[0])[0] . "(" . "$" . "oimo" . str_replace(" ","_",(trim(  str_replace(explode(',',explode(" ",(trim($gdfs[$itf])))[0])[0],'',$gdfs[$itf])   ))) . "); " . chr(10);

      } else if (strpos(strtoupper(trim($gdfs[$itf])), "COPY") === false) {

      $gfcds.=chr(10) . " image" . explode(',',explode(" ",strtolower(trim($gdfs[$itf])))[0])[0] . "(" . "$" . "oimo" . str_replace(" ","_",(trim(  str_replace(explode(',',explode(" ",(trim($gdfs[$itf])))[0])[0],'',$gdfs[$itf])   ))) . "); " . chr(10);

      } else {

      $gfcds.=chr(10) . " image" . explode(',',explode(" ",strtolower(trim($gdfs[$itf])))[0])[0] . "(" . "$" . "oimo" . "," . "$" . "oimo" . explode("," . "$" . "oimo", $gdfs[$itf])[1] . "); " . chr(10);

      }

     }

    }

 }



?>

 … to work with modified PHP writes PHP of the ilk …

<?php echo ”



function ourimagecreatefromstring(\$inidis) {

global \$imvgn, \$imafn, \$imqty, \$imgds, \$gfcds;

  if ((\$imvgn . \$imafn . \$imqty . \$imgds) != '' && strpos(\$inidis, ';base64,') !== false) {

    \$extis=str_replace('jpeg','jpg',explode('/', explode(';base64,', \$inidis)[0])[1]);

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, base64_encode(explode(';base64,', \$inidis)[1]));

    \$fzis=filesize(\$sofarout);

    if (trim(explode('|', \$imvgn . \$imafn . \$imqty . \$imgds)[0]) != '') {

    exec('" . $immogpath . "mogrify ' . explode('|', \$imvgn . \$imafn . \$imqty . \$imgds)[0] . ' /tmp/imtmp.' . \$extis);

    }

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false ||

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    \$oimo=null;

    if (strtolower(\$extis) == 'png') {

      \$oimo=imagecreatefrompng('/tmp/imtmp.' . \$extis); " . $gfcds . "

    } else if (strtolower(\$extis) == 'bmp') {

      \$oimo=imagecreatefrombmp('/tmp/imtmp.' . \$extis); " . $gfcds . "

    } else if (strtolower(\$extis) == 'gif') {

      \$oimo=imagecreatefromgif('/tmp/imtmp.' . \$extis); " . $gfcds . "

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      \$oimo=imagecreatefromjpeg('/tmp/imtmp.' . \$extis); " . $gfcds . "

    }

    if (\$oimo) { return \$oimo; }

  } else if ((\$imvgn . \$imafn . \$imqty . \$imgds) != '') {

    \$extis=str_replace('jpeg','jpg','" . $inextis . "');

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, \$inidis);

    \$fzis=filesize(\$sofarout);

    if (strpos(strtolower((\$imvgn . \$imafn . \$imqty . \$imgds)), '-format ') === false) { \$imvgn.=' -format " . str_replace('jpg','jpeg',$inextis) . " ';  }

    if (trim(explode('|', \$imvgn . \$imafn . \$imqty . \$imgds)[0]) != '') {

    exec('" . $immogpath . "mogrify ' . explode('|', \$imvgn . \$imafn . \$imqty . \$imgds)[0] . ' /tmp/imtmp.' . \$extis);

    }

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false) {

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    \$oimo=null;

    if (strtolower(\$extis) == 'png') {

      \$oimo=imagecreatefrompng('/tmp/imtmp.' . \$extis);  " . $gfcds . "

    } else if (strtolower(\$extis) == 'bmp') {

      \$oimo=imagecreatefrombmp('/tmp/imtmp.' . \$extis);  " . $gfcds . "

    } else if (strtolower(\$extis) == 'gif') {

      \$oimo=imagecreatefromgif('/tmp/imtmp.' . \$extis);  " . $gfcds . "

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      \$oimo=imagecreatefromjpeg('/tmp/imtmp.' . \$extis);  " . $gfcds . "

    }

    if (\$oimo) { return \$oimo; }

  }

  return imagecreatefromstring(\$inidis);

}



“; “?>

 … and to get there clientwise, in the Javascript …



function gdadd(oselo) {

 var pari=1, thispari='0';

 if (oselo.value != '') {

  //alert(oselo.value);

  var oselovalue=oselo.value.replace(',' + '$' + 'oimo','~' + '$' + 'oimo').split(',')[0];

  //alert(oselovalue);

  var oseloval=oselo.value;

  if (document.getElementById('imgds')) { if (document.getElementById('imgds').value == '') { document.getElementById('imgds').value='|';  } else { document.getElementById('imgds').value+=';'; } }

  oseloval=oseloval.replace(',' + '$' + 'oimo','~' + '$' + 'oimo');

  oseloval=oseloval.replace(oseloval.split(',')[0], '');

  while (oseloval.indexOf(',') != -1) {

  //alert(oseloval);

      if ((oseloval + ' ').substring(1).split(',')[0].trim() != '') {

      if ((' ' + (oseloval + ' ').substring(1).split(',')[0].trim() + ' ').toLowerCase().indexOf(' colour ') != -1) {

      thispari=prompt('Enter' + (' ' + (oseloval + ' ').substring(1).split(',')[0].trim() + ' ').toLowerCase().replace(' colour ', ' red,green,blue colour ') + 'parameter for GD ' + oselo.value.split(',')[0] + ' ' + pari + ' of ' + eval(-1 + oselo.value.replace(',' + '$' + 'oimo','').split(',').length)  + '?', '0');

      if (thispari == null) {

        thispari='0';

      } else if (thispari.trim() == '') {

        thispari='0';

      } else if (thispari.indexOf(',') == -1) {

        oselovalue+=',' + thispari + '';

      } else {

        oselovalue+=',imagecolorallocate(' + '$' + 'oimo,' + thispari + ')';

      }

      } else {

      thispari=prompt('Enter ' + (oseloval + ' ').substring(1).split(',')[0].trim() + ' parameter for GD ' + oselo.value.split(',')[0] + ' ' + pari + ' of ' + eval(-1 + oselo.value.replace(',' + '$' + 'oimo','').split(',').length)  + '?', '0');

      if (thispari == null) {

        thispari='0';

      } else {

        oselovalue+=',' + thispari;

      }

      }

      oseloval=oseloval.replace(',' + (oseloval + ' ').substring(1).split(',')[0].trim(),'').trim();

      } else {

      thispari=prompt('Enter numerical parameter for GD ' + oselo.value.split(',')[0] + ' ' + pari + ' of ' + eval(-1 + oselo.value.replace(',' + '$' + 'oimo','').split(',').length)  + '?', '0');

      oseloval=oseloval.replace(',','');

      if (thispari == null) {

        thispari='0';

      } else {

        oselovalue+=',' + thispari;

      }

      }

      //oseloval=oseloval.replace(oseloval.split(',')[0] + ',', '');

      //oseloval=oseloval.replace(',','');

      pari++;

  }

  if (document.getElementById('gdopt')) {

    document.getElementById('gdopt').innerHTML+='  ' + oselovalue.replace('~',',');

  }

  if (document.getElementById('imgds')) {

    document.getElementById('imgds').value+=oselovalue.replace('~',',');

    //document.getElementById('imgds').style.display='inline-block';

    //document.getElementById('imgds').style.width='300px';

    if (document.getElementById('smyim').innerHTML == '') {  document.getElementById('smyim').innerHTML='ImageMagick switches: '; }

  } else if (document.getElementById('myim')) {

    document.getElementById('myim').innerHTML='<span is=smyim>ImageMagick switches: </span><input id=imqty name=imqty type=text style=display:inline-block; value=\"\"></input><input id=imgds name=imgds type=hidden style=display:inline-block; value=\"|' + oselovalue.replace('~',',') + '\"></input>';

    document.getElementById('imqty').style.width='300px';

  }

  oselo.value='';

 }

}







Previous relevant Animated GIF Creator GD Filter Interfacing Tutorial is shown below.

Animated GIF Creator GD Filter Interfacing Tutorial


We are into image modification on the way to creating “compiled” animated GIF images, at the moment.  Yesterday’s Animated GIF Creator ImageMagick Interfacing Tutorial got us interfacing (or integrating) …

	ImageMagick batch processing “mogrify” ideas … and, today, it is the turn of …
	GD image filters …

Grayscale
Negate
Emboss
Edge Detect
Brightness
Contrast
Smooth
Colourize
Pixelate
Scatter
Mean Removal
Selective Blur
Gaussian Blur





 … into our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator PHP web application.





Previous relevant Animated GIF Creator ImageMagick Interfacing Tutorial is shown below.

Animated GIF Creator ImageMagick Interfacing Tutorial


Yes, you guessed it!  On top of yesterday’s ImageMagick Vignette Primer Tutorial, today we want to interface the ImageMagick batch processing “mogrify” ideas into our changed tutorial_to_animated_gif.php inhouse Animated GIF Creator PHP web application.

“Interfacing” (or integrating) into code often has you asking the question …



Where do we intervene to place our logic?



We’ve decided to “wrap” our PHP GD calls …

	imagecreatefromstring
	imagecreatefromjpeg
	imagecreatefrompng
	imagecreatefromgif
	imagecreatefrombmp


 … into inhouse “our” prefixed function versions as per (PHP writing out PHP) …

<?php echo ”



 \$imvgn='" . $imvgn . "'; /" . "/ vignette factor

 \$imafn='" . $imafn . "'; /" . "/ affine transformation

 \$imqty='" . $imqty . "'; /" . "/ image conversion and/or quality RE jpeg


 

function ourimagecreatefromstring(\$inidis) {

global \$imvgn, \$imafn, \$imqty;

  if ((\$imvgn . \$imafn . \$imqty) != '' && strpos(\$inidis, ';base64,') !== false) {

    \$extis=str_replace('jpeg','jpg',explode('/', explode(';base64,', \$inidis)[0])[1]);

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, base64_encode(explode(';base64,', \$inidis)[1]));

    \$fzis=filesize(\$sofarout);

    exec('" . $immogpath . "mogrify ' . \$imvgn . \$imafn . \$imqty . ' /tmp/imtmp.' . \$extis);

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false ||

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    if (strtolower(\$extis) == 'png') {

      return imagecreatefrompng('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'bmp') {

      return imagecreatefrombmp('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'gif') {

      return imagecreatefromgif('/tmp/imtmp.' . \$extis);

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      return imagecreatefromjpeg('/tmp/imtmp.' . \$extis);

    }

  } else if ((\$imvgn . \$imafn . \$imqty) != '') {

    \$extis=str_replace('jpeg','jpg','" . $inextis . "');

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, \$inidis);

    \$fzis=filesize(\$sofarout);

    if (strpos(strtolower((\$imvgn . \$imafn . \$imqty)), '-format ') === false) { \$imvgn.=' -format " . str_replace('jpg','jpeg',$inextis) . " ';  }

    exec('" . $immogpath . "mogrify ' . \$imvgn . \$imafn . \$imqty . ' /tmp/imtmp.' . \$extis);

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false) {

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    if (strtolower(\$extis) == 'png') {

      return imagecreatefrompng('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'bmp') {

      return imagecreatefrombmp('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'gif') {

      return imagecreatefromgif('/tmp/imtmp.' . \$extis);

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      return imagecreatefromjpeg('/tmp/imtmp.' . \$extis);

    }

  }

  return imagecreatefromstring(\$inidis);

}



function ourimagecreatefromjpeg(\$inidis) {

global \$imvgn, \$imafn, \$imqty;

  if ((\$imvgn . \$imafn . \$imqty) != '') {

    \$extis='jpg';

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, \$inidis);

    \$fzis=filesize(\$sofarout);

    exec('" . $immogpath . "mogrify ' . \$imvgn . \$imafn . \$imqty . ' /tmp/imtmp.' . \$extis);

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false) {

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    if (strtolower(\$extis) == 'png') {

      return imagecreatefrompng('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'bmp') {

      return imagecreatefrombmp('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'gif') {

      return imagecreatefromgif('/tmp/imtmp.' . \$extis);

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      return imagecreatefromjpeg('/tmp/imtmp.' . \$extis);

    }

  }

  return imagecreatefromjpeg(\$inidis);

}



function ourimagecreatefrompng(\$inidis) {

global \$imvgn, \$imafn, \$imqty;

  if ((\$imvgn . \$imafn . \$imqty) != '') {

    \$extis='png';

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, \$inidis);

    \$fzis=filesize(\$sofarout);

    exec('" . $immogpath . "mogrify ' . \$imvgn . \$imafn . \$imqty . ' /tmp/imtmp.' . \$extis);

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false) {

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    if (strtolower(\$extis) == 'png') {

      return imagecreatefrompng('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'bmp') {

      return imagecreatefrombmp('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'gif') {

      return imagecreatefromgif('/tmp/imtmp.' . \$extis);

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      return imagecreatefromjpeg('/tmp/imtmp.' . \$extis);

    }

  }

  return imagecreatefrompng(\$inidis);

}



function ourimagecreatefromgif(\$inidis) {

global \$imvgn, \$imafn, \$imqty;

  if ((\$imvgn . \$imafn . \$imqty) != '') {

    \$extis='gif';

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, \$inidis);

    \$fzis=filesize(\$sofarout);

    exec('" . $immogpath . "mogrify ' . \$imvgn . \$imafn . \$imqty . ' /tmp/imtmp.' . \$extis);

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false) {

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    if (strtolower(\$extis) == 'png') {

      return imagecreatefrompng('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'bmp') {

      return imagecreatefrombmp('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'gif') {

      return imagecreatefromgif('/tmp/imtmp.' . \$extis);

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      return imagecreatefromjpeg('/tmp/imtmp.' . \$extis);

    }

  }

  return imagecreatefromgif(\$inidis);

}



function ourimagecreatefrombmp(\$inidis) {

global \$imvgn, \$imafn, \$imqty;

  if ((\$imvgn . \$imafn . \$imqty) != '') {

    \$extis='bmp';

    \$inextis=\$extis;

    \$sofarout='/tmp/imtmp.' . \$extis;

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       unlink(\$imfilename);

    }

    file_put_contents(\$sofarout, \$inidis);

    \$fzis=filesize(\$sofarout);

    exec('" . $immogpath . "mogrify ' . \$imvgn . \$imafn . \$imqty . ' /tmp/imtmp.' . \$extis);

    foreach (glob('/tmp/imtmp.*') as \$imfilename) {

       if (filesize(\$imfilename) != \$fzis) {  // strpos(\$imfilename, '.' . \$extis) === false) {

         \$sofarout=\$imfilename;

         \$extis=explode('.', \$imfilename)[1];

       }

    }

    if (strtolower(\$extis) == 'png') {

      return imagecreatefrompng('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'bmp') {

      return imagecreatefrombmp('/tmp/imtmp.' . \$extis);

    } else if (strtolower(\$extis) == 'gif') {

      return imagecreatefromgif('/tmp/imtmp.' . \$extis);

    } else if (strpos(strtolower(\$extis), 'jp') !== false) {

      return imagecreatefromjpeg('/tmp/imtmp.' . \$extis);

    }

  }

  return imagecreatefrombmp(\$inidis);

}



“; ?>

 … and change existant calls into (equivalent inhouse) “our” function calls as above.





Previous relevant ImageMagick Vignette Primer Tutorial is shown below.

ImageMagick Vignette Primer Tutorial


Continuing on with the  ImageMagick batch processing “mogrify” ideas of yesterday’s ImageMagick Batch Image Conversion Affine Transformation Tutorial and the “vignette” image editing ideas of Gimp Vignette Primer Tutorial, as below, today, we took some pet photos with an iPad’s Camera app and shared them off the Photos app via two Mail sharing option emails containing seven attachments each.  Using an iPad, the JPEG “jpg” output files were too big for our inhouse Animated GIF Creator PHP web application to handle, and so to perform the …

	animated GIF presentation, off these downloaded email photo attachments … and along the way …
	quality adjusted them (yes, “mogrify” does not stuff JPG to JPG conversions, and we used “mogrify” -quality 20% switch here) … and …
	rotate them 180 degrees (“mogrify” uses switches -affine -1,0,0,-1,0,0 -transform +repage here) … and …
	vignette 50% (“mogrify” uses switch -vignette 50 here)


 … on the way to compiling into an animated GIF image, and we turned to ImageMagick again, using its affine transformation talents, along with its awesome vignetting talents …



Please choose an ImageMagick batch mogrify JPG to JPG with Affine Transformation and/or Vignetting command below
mogrify -quality 20% petvignettes12/*.jpg -comment “Straight off iPad 3x smaller to 1100×820 pet_photos_jpg_to_quality_20_jpg_1100_820.gif”
mogrify -quality 20% -affine -1,0,0,-1,0,0 -transform +repage petvignettes12/*.jpg -comment “iPad 3x smaller to 1100×820 pet_photos_jpg_to_quality_20_jpg_1100_820_180.gif copied to pet_photos_jpg_to_quality_20_jpg_1100_820_180_copy.gif”
mogrify -quality 20% -affine -1,0,0,-1,0,0 -transform +repage -vignette 50 petvignettes12/*.jpg -comment “iPad 3x smaller to 1100×820 pet_photos_jpg_to_quality_20_jpg_1100_820_180_vignette_50.gif”
mogrify -vignette 50 petvignettes12/*_copy.gif -comment “pet_photos_jpg_to_quality_20_jpg_1100_820_180_copy.gif”









 … where the last two dropdown options will be similar, the last showing the input image into ImageMagick can be an animated GIF that is truely treated like an animated GIF.

By the way, should you be interested in photo orientation off a mobile device camera, have a read of PHP Exif Image Information Revisit Tutorial.

Nala and Luna and Charlie bid you a fond farewell!





Previous relevant Gimp Vignette Primer Tutorial is shown below.

Gimp Vignette Primer Tutorial


The last time we talked about the miraculous, redolent and amazing image editor called Gimp am sure there was someone in a shower … it stands to reason … and one of those showerers, surely, would have been singing The Gimp Song … and if not … why not? … but we digress … anyway we had the  Gimp Transparency Primer Tutorial as shown below go into some image transparency issues with Gimp.

In today’s tutorial we make use of a great tutorial (even so far as with direct quotes below) called Add a Vignette to a Photograph with GIMP (thanks) to try a photographic technique called vignetting on one of the photographs we added, recently, into the mix of those of the Custom Header Image mix at this blog … specifically the one of Nala, the dog, on the door ledge.  Need to warn you here and now that if there was the time all over again, it would be better achieved that second time around, but this is not the point with learning, but rather getting some starting point with a great “product” like Gimp, and trying it yourself, once you have a method.  It boils down to:

	Open Gimp graphical editor application
	File->Open … pick your image file
	Layer->New Layer (we’ll call “Vg”) … pick Foreground Colour
	In the Layers dialog, click on your “Vg” layer to select it, and select Soft light from the “Mode” drop-down box
	Right click on your “Vg” layer and go to Add Layer Mask. In the dialog that pops up, you want “Initialise Layer Mask to” set to “White (full opacity)”. Click “Add”
	Below Opacity bar select Link icon next to Eye icon, which will already be showing
	Use the freeform select tool (press F to bring this up) and draw a selection somewhere around the primary point of interest in your photo
	Use your bucket tool (Shift+B) and click within the selection to fill it
	Deselect your selection with Select->None
	Go to Filters->Blur->Gaussian Blur. In the dialog that comes up, you want “Radius” set to a very large amount; a tenth of the longest edge of the photo is not too much
	Click on your “Vg” layer to select it (if it isn’t already selected), and then slide the opacity slider towards the right until the effect is subtle enough. Our (ever so subtle) example of Nala, in the tutorial, used an opacity of about 66%
	Click Export button in two windows (NB. this overwrites the image file, so if this is not desirable, export to a different image file name and/or type)


Here is an image comparison link.

As with most Gimp ideas, jump in and give it a go, as you’ll find your own ways and means of using this great product … am pretty sure.

Link to Gimp “spiritual home” … here.

Link to Gimp forum … here.



Previous relevant Gimp Transparency Primer Tutorial is shown below.

Gimp Transparency Primer Tutorial


Here is a tutorial that adds to a previous Gimp Layers Primer Tutorial as shown below, and gives you more insight into the massive possibilities of using a sophisticated image editor and use layers with various amounts of transparency, especially suited to use with png image files.

Today’s tutorial where we construct a Birthday Card that needs tweaking for the words in front to be seen a bit more clearly, by making the image behind a bit more transparent, changes the transparency of a single image via:

	Open Gimp graphical editor application
	File->Open Layers … pick your image file
	If Layers window not showing, make it show via Windows->Layers – Brushes
	Below Opacity bar select Link icon next to Eye icon, which will already be showing
	Change Opacity bar setting to a value of Transparency (100% is Opaque, 0% is Transparent) that suits … today we do 70%
	File->Export
	Click Export button in two windows (NB. this overwrites the image file, so if this is not desirable, export to a different image file name and/or type)


As with most Gimp ideas, jump in and give it a go, as you’ll find your own ways and means of using this great product … am pretty sure.

Link to Gimp “spiritual home” … here.

Link to Gimp forum … here.



Previous relevant Gimp Layers Primer Tutorial is shown below.

Gimp Layers Primer Tutorial


Here is a tutorial that gives you an insight into the massive possibilities of using a sophisticated image editor and use layers with various amounts of transparency, especially suited to use with png image files.

Transparency (or its obverse, opacity) can be used to have the one image achieve several “ends” (ie. purposes).  Although it is a bit of a clumsy example in the tutorial, you can see that the technique can be used for artistic purposes … often called “Photoshopping” (named after the more famous, and also brilliant, rival product, Photoshop).

Lots of those classic “Photoshopping” techniques can be achieved in Gimp, and some other tutorials at this blog touch on that.

Am sure you can imagine what the concept of a layer is with regard to image manipulation.   Within Gimp, for beginners not used to this concept, you find yourself underestimating and underplaying what can be achieved with the various layers of a multi-layered image.   In simplistic terms each layer has the functionality in Gimp to be treated as a whole new image, and this is the best way to think of it when trying to achieve what you want to achieve with Gimp.

Link to Gimp “spiritual home” … here.

Link to Gimp forum … here.
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